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You may not reproduce, transmit, transcribe, store in a retrieval system or translate
into any human or computer language this manual and software. These actions, in
any form or by any means, are illegal without the express written permission of Pu-
ritas Springs Software.
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During the period of time before a major upgrade, if the disk that makes up the
then-current version of this software is defective, then return the software to Puritas
Springs Software, 645 McKee Trail, Hinckley, Ohio 44233-9209 and a replace-
ment disk will be mailed to you. Puritas Springs reserves the right to define and
decide what constitutes a major upgrade.
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Puritas Springs Software provides U.S. Gift Tax for Windows, consisting of both
the software and this manual, "AS IS." The software and manual carry no warranty
as to performance, merchantability or fithess for any particular use. Puritas
Springs Software specifically disclaims all warranties, express or implied, regard-
ing the software or our services, and Puritas Springs Software does not warrant
that the software or services are free from defects, interruption, errors or other pro-
gram limitations. For states containing limitations on implied warranties, any such
implied warranties are limited to 60 days from the date of purchase. The rights pro-
vided by this Limited Warranty shall be limited to the original, registered and re-
corded purchaser of the software. Said rights are limited to the cost of the software
and are non-transferable. You assume all liability and responsibility for the accu-
racy of any form produced by this software. Recognizing this, Puritas Springs
Software has exercised due care in the preparation of the software and manual. In
no event, however, shall the authors or publisher be liable for direct, incidental or
consequential damages, or damages of any type, arising from the use of U.S. Gift
Tax for Windows.

This Agreement sets forth Puritas Springs Software’s entire liability and your ex-
clusive rights and remedy with respect to the software. Headings are included for
convenience and shall not be considered in interpreting this Agreement. This
Agreement does not limit any rights that Puritas Springs Software may have un-
der trade secret, copyright, patent or other laws, federal or state.
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Getting Started

U.S. Gift Tax for Windows (W709_09) isa
true 32-bit Windows application and runs on
any computer running Windows 7, Windows
Vista, Windows XP, Windows 2000, Win-
dows NT, Windows ME, or Windows 98.

United States copyright laws protect
W709_09 as the property of Puritas Springs Software. Y our W709_09 distribution
disk contains aregistered serial number that is hidden in various places inside the
software. Possessors of unauthorized copies violate Federal law.

As noted in the following installation instructions, the files on the W709_09 compact
disk are compressed for distribution purposes. Y ou cannot make use of these files
without first decompressing them. You cannot simply copy themto your hard drive
manually. You must “install” them using the SETUP application that you'll find on
the distribution disk.

W709_09 works with any Windows printer and requires a monitor capable of dis-
playing a minimum of 256 colors at a minimum resolution of 800 x 600.

Free Upgrades

The programming and production constraints imposed by the time-sensitive nature
of the subject matter are obvious. Asistrue of all tax software, upgrades are very
important. Y ou can upgrade your software by using W709_09's Download Up-
grade function on the Help menu.

If you ever download an upgrade over the Internet, please read this section for addi-
tional useful information. First, it isimportant to know that removing the
W709_09 program using Windows Add/Remove function in Control Panel
will not delete or harm your client files. That being said, you should always back
up the Files subfolder that iswithin the W709_09 program folder. It is there that
your client files are stored. The reason we even bother referring to the removal proc-
essis because Microsoft’ sinstaller application requires that you uninstall your cur-
rent Version 13 installation of W709_09. In this context, again we want to empha-
size that your client files will not be affected.

Steps for Removing W709 09

We provide comprehensive instructions on removing the W709_09 application on
page 6 of this manual in the section titled, “Updating & Reinstallation.”
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Installing 709 09

+ )
Install U.S. Gift Tax for Windows (W709_09)
to your hard drive by following the steps out-
lined below. Before starting the installation, we
should mention that the files on the distribution
compact disk (CD) are compressed, and there-
fore, you must “install” W709_09 to your computer rather than simply copying the
files from the CD to your hard drive. For that same reason, you cannot run W709_09
from the CD. You must install W709_09 to your hard drive.

Network Computers. W709_09 is an ordinary 32-bit Windows program and it runs
on network installations so long as it is properly configured and you have purchased a
network license. In the case of network computers, the types and implementations are
diverse and we cannot give network-specific technical support although we occasion-
ally answer questions about W709 09 to assist network administrators on issuesin-
volving installation and setup if you have purchased a network license.

+ )
A. Placethedisk in your drive.

B. On most systems, depending on your license, installation will begin automatically,
however, if theinstallation wizard does not start automatically, take the following
three steps:

1. Pressthe Start button;
2. Click onthe Run item; and

3. Inthe Run dialog, type the command shown below. Note that the CD
driveis not always assigned the letter “D” on all systems. You must use
the correct driveletter for your system, i.e. “E:\SETUP.EXE.”

D:\SETUP.EXE

C. The Setup progress meter will appear briefly until the Welcome dialog appears.
Click the Next button to proceed with installation. Follow standard Windows installa-
tion protocol by making sure all other programs/applications are turned off—not just
minimized, but terminated. Click Cancel if you want to abort installation.
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D. The Puritas Springs Softwar e Licensing Agreement appears in the next dialog.
Review the agreement and click the button labeled “1 accept the terms in the li-
cense agreement.” Then press the Next button to accept the terms and conditions
of the license and continue with the installation. If you do not agree to the terms of
the Licensing Agreement, you will not be able to continue installing the program.

E. Verify your user identification information and click the Next button.

F. Verify the installation directory. We strongly recommend C:\Program
Files\Puritas\WBank 7\ which is the default and we do not support alternate installa-

tion locations. Click the Next button to continue.

G. Veify the database directory. We strongly recommend C:\Puritas\W 709 09\
which is the default and we do not support alternate installation locations. Click the

Next button to continue.

H. The Ready to Install dialog marks the end of installation and lets you verify your
installation parameters. If everything is correct, click the Install button.

|. Asinstallation begins a progress meter will keep you informed as the W709_09
files are transferred from the CD to your hard drive.

J. The InstallShield Wizard Completed dialog notifies you when the installation
process is successfully completed. Click on the Finish button.

Updating and Reinstallation

1. Download the Upgrade.
A. Click on W709_09's Help menu and select Download Upgrade.

B. Inthe Download Upgrade dialog box, click on the Check Availability but-
ton. Note that some systems, typically networks, may have security software
and/or hardware in place that prohibit downloading executablefiles. If thisis
true in your office or you are having problems with the download, check with
your network administrator.

C. After clicking the Check Availability button, you may get one of three re-
Sponses.

1) You are notified that a newer version is available and the Check Avail-
ability button changes to a Download Upgrade button. Click on
Download Upgrade button and see the file downloading.

2) You arenotified that there is no newer version available. You're done.

3) A messageindicates an error, i.e., “HTTP Get Failed.” Tak with your
network administrator or send in your disk according to our instructions
on the Current Versions page of our web site: www.puritas-
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springs.com.

2. Remove W709_09. First, it isimportant to know that removing the W709_09
program using Windows Add/Remove function will not delete or harm
your client files. That being said, you should always back up the Files subfolder
that is contained within the W709_09 program folder. It is there that your client
files are stored. The default path is C:\Puritas\W709 09\. Here are the steps for
removing the prior version of W709_09.

A. Exit the W709_09 program.

B. Click on the Start button. From the Start menu select Settings, and then
Control Panel. Note that in some Windows versions, you may need to navi-
gate to Control Panel in adifferent way. However, oncein Control Panel,
double-click the Add/Remove Programs icon. If you don’'t see the Add/
Remove Programs icon, you may need to click on the Classic View link
or option. Also note that some versions of Windows (Windows 7 & Windows
Vista) place the add/remove functionality in the Programs and Features
area of Control Panel.

C. Onceyou find your way to the list of installed programs, select W709_09
from the list. With theW709_09 item highlighted, click the Add/Remove
button. Again, in some versions of Windows you may need to click on the
Uninstall button or link.

D. When the Welcome dialog appears, click the Next button to begin the re-
moval process.

E. Thenext dialog box to appear istitled Program Maintenance. Click the
radio button next the Remove item, and then click the Next button.

F. Remove the Program isthe next dialog box to appear. The InstallShield
Wizard will begin to remove the old W709 09 program when you click the
Remove button.

G. You are notified when the removal function is complete. In the dialog box
that appears, click the Finish button to close the InstallShield Wizard

3. Install the New Version. The final step in the upgrade processisto install the
new version by executing the file you downloaded. The name of the downloaded
fileissetupW709_09.exe (note that sometimes the exe extension is hidden)
and it islocated by default at C:\Puritas\W709_09\. When you find thefile,
double-click on it and follow the installation instructions contained on page 5 of
thismanual. If you don’t know how to find thefile, try following these steps:

A Goto My Computer

B Double-click the C:/ or Local Hard Drive icon.
C Double-click the Puritas folder.

D Double-click theW709 09 folder.

Y ou should see thefile (setupw709_09.exe) and double-click on it to begin instal-
lation.
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Entering Information

A Gift Tax Tutorial

U.S. Gift Tax for Windows — Version 13 - 2009
When you start U.S. Gift Tax (W709_09),

you see the Main Window and you' ve

cleared a blank set of gift tax forms and

S\X}
schedules (blank except for any informa- -~

tion present in the DEFAULT file). Click \g,}

on the Main Window’sitem 1. Complete
Form 709, Page 1, Part 1. Usethe<TAB> key to move from field to field. While
we're on the subject, note that shift  moves focus backwards. Y ou won®go too far
before you notice that you cannot tab to every field. Some fields or lines are calcu-
lated by W709 09 based on information you entered elsewhere. Line 1 of Page 1 isan
example. W709_09 enters the amount from Schedule A based on information you
send to Schedule A viayour entriesin the Gift Tax Worksheet. All you do is enter
gift/donee information in the Gift Tax Worksheet and direct it to go to Schedule A,
Part 1. The value of the gift is sent to Part 1 of Schedule A and the total from Sched-
ule A isincluded on Line 1 of Page 1. Y ou do not make an entry on Schedule A or on
Page 1, Line 1. Y ou only make your entry on the worksheet. W709 09 handles every-
thing else automatically.

x’

~

1. Complete Form 709, Page 1, Part 1.

When you first start W709_09 or select File|New, you see the Main Window from
which most program functions can be performed. The right side is an instruction pane
that explainsits use. Click on thefirst item “1. Form 709, Page 1, Part 1” and
you'll see ablank gift tax return on which to begin working. The cursor is blinking in
the "Donor’s first name and middle initial" field. Type "James P"* and then press the

key. Pressingthe  key takes you to the next field—"Donor's last name." In
that field type: "Sample." Complete the rest of Part 1 as shown below. Remember to
press to movefrom fieldto field.

Field Answer

Donor's social security number 123-45-6789
Address 1234 Main Street
Legal residence Cuyahoga, Ohio
City, state and ZIP Code Cleveland, Ohio 44111
Citizenship United States

If donor died during the year ... Unchecked

Date of death

If you received an extension Unchecked
...total number of separate donees ...

Line 11a checkbox Yes

Line 11b checkbox No

Line 12 checkbox No

Line 13 - consenting spouse

Line 14 - SSN

Line 15 checkbox No

Line 16 checkboxes No

Line 17 checkbox No
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Y our screen should look like the one shown below:

Completed Partl of Form 709, Page 1.

This nearly completes the Page 1 of Form 709.

BLUE BOXES: You'll notice that text input box for Line 1 of Part 2 has an aqua-
colored background. The aqua background means that you do not need to make an
entry on that line. W709_09 will complete that line based on entries you make on
other areas of the form. In the example of Line 1 of Part 2, that line will complete
itself when you complete Schedule A, Part 3.

CHECKBOXES: In the case of check boxes, tab to the Yes or No field and either
press the space bar or click in the check box areato place or remove a checkmark.
Youmust  off thefield for any applicable calculation results to be displayed.

2. Name & SaveFile.

The next item in the Main Window's treeview is 2. Name & Save Your File. If
you're following this tutorial, you haven’'t named your file yet.

This step provides atimely reminder to name and save your file. It also provides
quick accessto the Save As diaog. It®a good habit to save your fileand giveit a
name as soon as practical. Having completed Part1 of Form 709 sfirst page, now is
agood time. The storage location comes from the default 709 setting on the Op-
tions menu. By default the location is C:\Puritas\W709_09.

When you name your gift tax file, it®good to keep afew pointsin mind.
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1. Therule of thumb about saving is - early and often -- so you don®lose your
work.

2. Always usethe 709 extension - so you can open files by clicking on them and
see them in masked Open and Save As dialogs.

3. You can save your client files anywhere, but it®best to save your 709 filesin
the W709_09 folder located by default at: C:\Puritas\W709_09. So all your
gift tax files are together.

3. The Gift Tax Worksheet.

Y ou can display the Gift Tax Worksheet by pressing or by pressing the
Worksheet button on the button bar below the menu bar. The Worksheet button
looks like alittle spreadsheet and it has aWorksheet label or hint if you rest your
mouse cursor over the button for a second or two.

The Gift Tax Worksheet is divided into two sections. The top section is for making
your entries. The bottom section |ooks like a spreadsheet or database because gifts
arelisted in rows and columns. Each line or row of the worksheet represents a gift.
The general rule of theworksheet isthat gifts should be entered from left to
right. When you first see the Gift Tax Worksheet, the focus is in the Description
field of the first gift entry or line of the worksheet. It’s ready for you to begin mak-
ing your entry.

Note. The worksheet depicted on the following page was displayed on a 20" monitor
using a 1280 x 1024 display. If you're using a smaller resolution your worksheet
may be clipped at the right end thereby requiring you to scroll horizontally to see the
rightmost columns. Like many similar Windows components, you can resize any col-
umn’ s width by dragging the dividing line between column headings to the right or
left. The sameistrue of the vertical aspect. Y our entries can be arranged in any or-
der you like. Furthermore you can change the order of the entries by clicking on the
leftmost gray column (on the bottom section of the worksheet) and dragging a record
or entry to anew position in the table. If you have many entries, you may use the
vertical scroll bar or your Page Up and Page Down keysto see additional entries.

Description .... Usethisfield for describing the gift and detailing the donee’ s name,
address and relationship to the donor/taxpayer. If the gift consists of securities, you
must include the CUSIP number in thisfield. The Description editor is opened by
double-clicking in the Description column. When the mini-editor appears, you can
enter any amount of text you require. You can include hard carriage returns in your
entries, but DO NOT ENTER ANY TAB CHARACTERS in your descriptions.
Click the Ok button in the mini-editor to return to the Worksheet grid.

Some users like to put two carriage returns at the end of each description, because
when the forms are completed, each gift is separated from the next by ablank line.
Otherwise, each entry in a schedule follows the next without any dividing space.

Here's the information we typed in the mini-editor including hard carriage returns:
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Completed First Gift in Worksheet (Schedule C Column truncated)

Elizabeth W Grenessem
927 Hampton Way
Baltimore, Maryland 67890

Daughter of donor

800 shs common stock
in Montgomery Manufacturing Corp
CUSIP NO 273478283

If you're still wondering about the carriage returns, think of them just like you
would in aword processor. If you use a carriage return at the end of line, that point
will aways mark the end or aline or sentence. If you don’'t use a carriage return at
the end of aline or sentence, it, and the succeeding sentence, will join and word
wrap depending on the “margins” or form-allocated space just like any word proces-
sor. If we were to type this entry so that any succeeding entries would be separated
by ablank line, here’s how we'd typeit:

Elizabeth W Grenessem
927 Hampton Way
Baltimore, Maryland 67890

Daughter of donor

800 shs common stock
in Montgomery Manufacturing Corp
CUSIP NO 273478283

It'stheinvisible carriage return at the very end of the description that creates a blank
line at the end of the entry so that the next entry will separated by one blank line.

Send Thisltem To .... Thisfield lets you direct your entry to any specific form,
schedule or part, or any combination of forms, schedules or parts. Regardless of how
much information you type on aline or record in the worksheet, nothing will happen
unless you tell W709_09 where to send that entry. In our sample, we're placing a
checkmark next to Sched A, Pt 2. In addition, giftsthat are listed on Schedule A,
Part 2 also go on Schedule C, so check the Schedule C check box also and let’s
move on to the Schedule A column.

Schedule A. The Schedule A fields are contained in adialog which you can display
by clicking on the Schedule A Change button. Schedule A has three parts and each
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of those three partsis divided into two subparts. one for gifts by the donee and one
for gifts by the donee’ s spouse. If you're using Schedule A, you'll be filling out
most of the fieldsin the Schedule A column. Our sample uses the following infor-
mation from top to bottom in the Schedule A diaog:

Was this a gift by a spouse? No, leave unchecked
Note: If it is a gift by the spouse, this box is checked
and the entry will go to the second subpart of Part 1
of Schedule A. If the box is left unchecked (as in this
example), the entry goes to the first subpart of Part
1.

Donor's adjusted basis in gift 30000
Note: Do not enter dollar signs ($) or commas (,) in
dollar amounts. W709_05 will format dollar amounts
automatically. Also, remember the W709_05 rounds
amounts in accordance with IRS regulations, so it's
not even necessary to use decimal periods or cents.
The dollar amount will automatically be formatted as:

$30,000.
Date of gift 11/1/2009
Value at date of gift 183661

Note: Same caution as above regarding dollar
amounts. This amount becomes: $183,661.

Was this gift a split gift? Unchecked.
Note: If this box is checked then column (G) is
completed essentially halving the amount in column
H. If the box is unchecked then the amount from
column (F) appears also in column (H)

Part 3, GST Exemption Allocated 0
Note: This field is totaled for all records in Schedule
A, Part 3, and the total is placed on Schedule C,
Part 2, Line 5, captioned: “Allocation of exemption
to transfers reported on Schedule A, Part 3.”

Part 4, Line 2, Annual exclusions 10000
Note: The annual exclusion that applies to this gift
is entered here. Unlike the other information in
Schedule A, the annual exclusions are totaled and
the total is placed on Schedule A, Part 4, Line 2—
“Total annual exclusion for gifts listed in Parts 1, 2
and 3”. This entry will be formatted: $10,000.

Thelast two fields of Schedule A are checkboxes that correspond to Column C in
Parts 2 and 3. If you check the appropriate box on the worksheet, an “ X" will appear
on the corresponding line in Column C related to IRC 2632 elections.

Schedule B. Complete Schedule B fields only if you answered “Y es’ to question
11aon page 1. In our example, the donor did not previously file a gift tax return for
aprior year, so Schedule B isleft blank. If there were previous gift tax returnsfiled
by the Donor, they would be summarized in Schedule B and you would enter an-
swers to the five fields in the column titled “ Schedule B” in the Gift Tax Work-
sheet. The fivefieldsin the Schedule B dialog correspond exactly to the five col-
umns of the published Schedule B, therefore no further explanation regarding
Schedule B will be given in this manual.



U.S. Gift Tax for Windows — Version 13 - 2009

Schedule C. In Schedule C you must list each of the gifts that you entered in Part 2
of Schedule A. Having completed the Schedule A fields, proceed to the Schedule
C diaog of the Gift Tax Worksheet by clicking the associated Change button.
There are only two fields to complete: the nontaxable portion of the gift (equating to
Column C of Schedule C) and allocation of GST exemption (the totals of which ap-
pear on line 5 of Schedule C, Part 2).

Nontaxable portion of transfer 5000
Allocation of exemption to transfers reported 2500
on Schedule A, Part 3 Note: This field is totaled for all the records and the

total is placed on Schedule C

That’sit for the Gift Tax Worksheet in this sample; however, if you had twenty
giftsto report you' d enter them all in the Worksheet the same way. There' s not
much to it. Y ou don’'t really compl ete the schedul es themsel ves because they will
compl ete themsel ves based on your Worksheet entries.

Additional new entries can be added by using or the Add at End button. Ex-
isting entries can be changed by using the Page Up and Page Down keysto move
to the entry you want to change. When you’ re on the entry you want to change, just
start typing. There are no special commands required.

Add at End. We sometimes get technical support questions about the Gift Tax
Worksheet that relate to the Add at End function. The typical conceptua error that
users make is in deciding whether to click Add at End before or after making an
entry. The correct answer is before. You click Add at End to obtain a new blank
record or line in the table. The only time you don’t need to click Add at End before
making an entry is when you' re making the very first entry. You don’t need to click
on Add at End because the first entry already exists in the table when you start. If
you accidentally add an entry that you don’t need, delete it immediately or it will
eventually cause problems.

When you’ re finished with an entry, and you' re not going to add any more, you must
“post” or “save” your last entry. Here's how “posting” or “saving” works. If you're
finished with an entry and you want to save it, just click the Save to Table button
or use the <CTRL><T> keyboard combination.

3. Review thevarious schedules or worksheets adding any remain-
ing information necessary for completion.

There®not much left to do actually. In rough outline, here®what®|eft to review or
enter:

Form 709 - Page 1 lines 7, 13 and 18 and the signature and preparer inform
ration

Page 2 the checkboxes in sections A & B at the top of the page

Page 3 lines4,5 & 7 of Schedule A, Part 4; and line 17.

Page 4 the checkboxesin Schedule C, Part 2 and lines 1,2 & 6.
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4. Print therequired forms and schedules

When you click on the fourth item in the Main Window the dialog below appears:
The used forms are selected automatically although you check or clear any items
you want.

The Select Forms Dialog
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Don't Neglect Qur Help Files

This paper manual is merely an outline of the basics of installation, getting started
and atutoria on basic information entry. Y ou can get additional help viathe pro-
gram’s Help|Table of Contents menu. This program has context-sensitive help.
That means that you get help on a specific menu item without searching for that topic.
Simply highlight the menu command and press . Many other objects on your
screen have associated help topics, i.e., window scaling. When in doubt, move focus
to the component object and press

The mouse won't work to highlight a menu command. Y ou must use the keyboard.
To give an example, if you wanted help with the Save As command you would press

to pull down the File menu, and use the arrow keys to highlight the Save As
command. With the command highlighted pressthe  key.

If you're like us, you might be doubtful as to whether help files can be truly helpful.
Regardless of any drawbacks, we found them to have significant benefits over their
paper counterpart.

Help IsAlwaysThere

When we were at the office, the manual was at home. When we were on the computer
at home, the manual was at the office. On unfortunate occasions, that alone can make
you lose aday. It never happens with help files. They’ re always there. A copy for
your home computer, and a separate one for the office. Ditto for your laptop! When
you' re desperate for information, you can always count on its accessibility.

Help IsHyperlinked, Searchable & Better Indexed.

We took extratime to develop alogical system of indexing. Y ou should find that a
help file's searchability can be atime-saver when you' re looking for a snatch of text.
The point and click links between key words provide instant information without
fumbling through page after page looking for something. This non-linear characteris-
tic is part of what makes help files so uniquely useful.

Help IsUp To Date

Because they are printed in large quantities, paper manuals fall out of synch with last-
minute or late-minor programming changes. Help files, on the other hand, are easier
to keep current with programming changes because their modification involves no
additional processing steps to implement (i.e., physical transportation, printing, bind-
ing, €tc.).

Paper Fix

Don't forget that any help topic can be printed simply by pressing the help window’s
Print button, or using the menu’s Print Topic command.
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Essential Help Topics

Checking out these help topics before starting
W709_09 will reduce the learning curve, athough
you'll find W709_09 relatively straightforward to
use.

1. Tutoria - Entering Information

Thistopic isagood starter because it explains the
process of entering information and saving it in afile
you name. It takes you through a step-by-step tour of completing a gift tax return
from beginning to end.

2. What is the worksheet used for?

The Gift Tax worksheet is the central areawhere W709_09 keeps financia infor-

mation. This short topic describes how to enter information and explains the pur-

pose of record numbers. Becoming acquainted with this information can help you
avoid any possible pitfallsin using the worksheet.

3. What isthe DEFAULT.709 file?

This topic explains how to customize the blank, start-up tax return so that common
information appears automatically when you select New from the File menu.

4. Using The Keyboard
Thisisagood topic to print because it summarizes al the keyboard shortcut com-
mands in the program.

5. Overriding Answers
Y ou will use this command when you need to manipulate entries in text input dia-
logs that contain green colored texts.

6. View Scde

This command lets you fine tune the form size to fit the display size and resolution
you have on your computer monitor.

7. Common Questions

If we get recurring questions about a particular facet of W709_09 operation, you
will find the relevant help topic cited here.



